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This guide contains the following topics:

• “About this guide” on page 2

• “Protocol description” on page 4

• “Before you start” on page 4

• “Starting up the workstation” on page 8

• “Opening the protocol” on page 10

• “Setting up the protocol” on page 13

• “Running the protocol” on page 19

• “How to return to the Applications Library” on page 24



1   Automated Plate Labeling Protocol Guide
About this guide

2 Automated Plate Labeling Protocol Guide

About this guide

This guide describes how to run the Automated Plate Labeling protocol using 
an Agilent G5590A BenchCel Workstation that includes the Microplate Labeler. 
This guide describes how to open the protocol and run it using the BenchCel 
Workstations software. For details on the task parameters or how create a 
different protocol, see the VWorks Automation Control User Guide.

Assumptions

This guide assumes the following:

• The Agilent G5590A BenchCel Workstation with Microplate Labeler has 
been installed and is operating correctly. 

• The device teachpoints have been set and verified.

• You are familiar with the devices in the workstation and the VWorks 
Automation Control software.

Safety information

Ensure that you are properly trained in:

• General laboratory safety

• The correct and safe operation of the workstation

• Emergency stops

For general safety precautions, intended product use statement, and the list of 
safety labels, see the Automation Solutions Products General Safety Guide. 

For detailed safety information, see the BenchCel Microplate Handler User 
Guide and the Microplate Labeler User Guide.

Related user guides and where to find them

You should use this guide in conjunction with the following guides:

• Automation Solutions Products General Safety Guide. Provides general 
safety information and describes potential safety hazards that you might 
encounter when using Agilent Automation Solutions products. A copy of 
this safety guide is included with your shipment.

• BenchCel Microplate Handler User Guide. Contains the safety guidelines 
and describes the installation, setup, operation, and maintenance 
procedures for the BenchCel Microplate Handler.

• Microplate Labeler User Guide. Describes the setup, operation, and 
maintenance procedures for the Microplate Labeler.

• VWorks Automation Control User Guide. Describes how to create, run, 
import, and export protocols.

• VWorks Automation Control Setup Guide. Explains how to define labware, 
specify pipetting speed and accuracy, manage labware in storage, and 
manage user accounts.

 

You can access these guides in the Literature Library page of the BenchCel 
Workstations software interface.
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You can find the user guides for all the Automation Solutions products in the 
VWorks knowledge base. You can open the knowledge base in the following 
ways:

• In the BenchCel Workstations software, go to the Literature Library page, and 
then click Open for the VWorks knowledge base.

• Within the VWorks software, select Help > Knowledge Base or press F1.

• From the Microsoft Windows 10 All Apps menu, select  
Agilent Technologies > VWorks Knowledge Base. 

 

You can also find these guides in the online VWorks knowledge base at 
www.agilent.com/chem/askb. 

http://www.agilent.com/chem/askb
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Protocol description 

Plate Labeling protocol. The Plate Labeling protocol automatically prints and 
applies barcode labels on up to n microplates in a single automated run. 

Note: The number (n) of microplates that a protocol can process depends on 
the number of labware racks on the BenchCel Microplate Handler. Depending 
on the model, the BenchCel Microplate Handler can have two, four, or six 
labware racks (BenchCel 2R, 4R, or 6R model).

Before you start

Hardware requirements

The following figures and table describe the workstation and the components 
required for the protocol. The BenchCel Microplate Handler in the workstation 
can be a BenchCel 2R, 4R, or 6R model.

IMPORTANT If your workstation includes additional devices and you want to 
use this protocol, the VWorks device file that is linked to the protocol must be 
edited to include all the workstation devices before you can run the protocol 
successfully. For instructions on how to modify a device file and link to the 
protocol, see the VWorks Automation Control User Guide.

Figure G5590A BenchCel Workstation BenchCel 6R with Microplate Labeler 

1 2

3

4
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Table Components of the G5590A BenchCel Workstation BenchCel with Microplate Labeler 

Software requirements

The minimum software requirements for running the protocol are as follows:

• Microsoft Windows 10 64- bit operating system

• VWorks Automation Control software 13.1

IMPORTANT VWorks Administrator or Technician privileges are required 
to make any changes to the protocol task settings.

• BenchCel Workstsations software 1.0

Item Name Description See...

1 Computer 
and 
monitor

The controlling computer that runs the VWorks 
Automation Control software. 

VWorks Automation 
Control User Guide

2 BenchCel 
Microplate 
Handler

The device that stores stacks of labware and moves 
labware to and from the other devices in the 
workstation. Depending on the BenchCel model, two, 
four, or six labware racks can be installed on the 
stackers. 

• BenchCel 2R has two stackers for labware racks.

• BenchCel 4R has four stackers for labware racks.

• BenchCel 6R has six stackers for labware racks.

The labware rack height can be 250- , 660- , or 860- mm.

BenchCel Microplate 
Handler User Guide

3 Safety 
equipment 

Emergency- stop pendants and shields protect operators 
from moving- parts hazards. 

BenchCel Microplate 
Handler User Guide 

4 Microplate 
Labeler

The device that automatically prints the barcode labels 
and applies them to the microplate. The primary 
components include a label printer, an applicator, and a 
plate stage.

Microplate Labeler 
User Guide
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The BenchCel Workstations software includes the device profiles for connecting 
to your devices and the files required to run the BenchCel Workstation 
protocols.

Media requirements

Ensure that the printer on the Microplate Labeler has sufficient ribbon and 
labels loaded for the number of labels you are applying in the protocol.

Figure Printer (side view) showing the feed paths of the ribbon (red) and labels (blue) 

• If you are loading ribbon and labels for the first time, see the Media 
Loading Guide included in the Agilent Microplate Labeler Media Kit for 
instructions.

• If you are replacing used ribbon and label rolls, see the Microplate Labeler 
User Guide for the printer cleaning procedure before you load the new 
ribbon and label rolls.

About the label format

By default, this protocol uses the format 1 label template, shown in the 
following figure.

Figure Format 1 template: Code 128 symbology above a small-font human-readable text field

This label format is only one of the ready- to- use templates (format 1–9) that 
are available for you to use on the Microplate Labeler. For a description of the 
different templates or instructions on how to create your own label format in 
Microplate Labeler Diagnostics, see the Microplate Labeler User Guide.
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Labware requirements

The labware that you use must have a corresponding labware definition in the 
VWorks software. By default, the Plate Labeling protocol specifies the 
96- well Greiner 655101 microplate. The VWorks software includes over 70 
labware definitions. If the labware that you want to label does not have a 
matching labware definition, you create one using the VWorks Labware Editor.

To open the Labware Editor:

1 In the VWorks software, click Tools > Labware Editor on the menubar.

2 The Labware Editor opens. 

3 In the Plate Properties tab, notice that the Plate Handling area contains the 
Lower plate at Microplate Labeler check box.

Figure Labware Editor window

• To use the top position (default) of the plate stage for this labware, 
clear the check box. 

• To lower the plate stage for this labware, select the check box.
                                                        

CAUTION Using labware that has not been defined in the Labware Editor can cause a 
collision, resulting in equipment damage. Ensure that the labware definition matches the 
labware that you use for the protocol.
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If the labware has a tall skirt (1) or has a raised surface on the sides 
(2), you can specify that the Microplate Labeler use the bottom position 
(or lower the stage) during the run so that the label can be applied 
above the skirt or raised surface.

The two vertical plate stage positions are set mechanically. To adjust the 
plate stage height on the Microplate Labeler, see the Microplate Labeler 
User Guide for instructions.

For detailed instructions on how to create labware definitions, see the VWorks 
Automation Control Setup Guide.

Starting up the workstation

To start up the workstation:

1 Start up the BenchCel Microplate Handler as follows:

a Position the BenchCel robot head underneath a stacker, and place the 
gripper arms to the right facing the Microplate Labeler.

b Turn on the BenchCel air supply.

c Turn on the BenchCel power.

Figure BenchCel rear panel
.

d Wait for the BenchCel head to finish the homing routine.
                                                        

label examplelabel example

1 2
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To start up the Microplate Labeler

1 Turn on the air supply. 

2 On the rear of the Microplate Labeler, check the air pressure gauge. Verify 
the air pressure is set within the following range: 

0.55 MPa (80 psi) to 0.58 MPa (85 psi)

Figure Microplate Labeler connection panel 

3 Verify that the communication cable and power cord are connected, but do 
not turn on the power yet. 

4 If you are using an Ethernet switch, turn on the power to the Ethernet 
switch.

5 On the Microplate Labeler connection panel, press the power switch to the 
on (|) position.

 IMPORTANT Ensure that the power switch on the printer remains in 
the on (|) position.

IMPORTANT Make sure the label formats that you plan to use are 
uploaded to the printer on the Microplate Labeler. For instructions, see 
the Microplate Labeler User Guide.

6 Turn on the computer and monitor. Wait for the Microsoft Windows 
operating system to finish starting up.

7 At the BenchCel Microplate Handler, install the labware racks on the 
stackers. See the BenchCel Microplate Handler User Guide. 

                                                        

WARNING  The device components can move when you turn on the power and the 
air. Keep fingers, hair, clothing, and jewelry away from the Microplate Labeler while it 
is in motion. Never touch any of the moving parts or attempt to move labware while 
the Microplate Labeler is in operation. The device could pinch, pierce, or bruise you.
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IMPORTANT Make sure the BenchCel power and compressed air are 
turned on before you install or uninstall a labware rack.

Figure Labware rack, front-load

Opening the protocol

IMPORTANT Ensure that the VWorks software is closed before you start the 
BenchCel Workstations software.

To open the protocol:

1 Start the BenchCel Workstations software . 

2 Click App Library. The VWorks software starts. 
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3 When the User Authentication dialog box opens, type your VWorks user name 
and password, and then click OK.

.

4 In the Applications Library form, click Full Screen ON/OFF to change the scale 
of the form display within the VWorks window so that the menubar and 
the Control and Standard toolbars are visible, as the following figure 
shows.

Figure Applications Library form displayed with Full Screen off 

Note: If the toolbars are not displayed in the VWorks window, right- click 
in the window, and then select the corresponding toolbar from the 
shortcut menu.

5 In the Plate Labeling area of the Applications Library form, click the button that 
corresponds to your BenchCel stacker configuration: BenchCel 2R App, 
BenchCel 4R App, or BenchCel 6R App.
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6 When the following VWorks initialization message appears, click Yes.

The initialization process establishes communication with the BenchCel 
Microplate Handler and Microplate Labeler and homes the devices.

The Plate Labeling protocol opens in the VWorks window.

Figure Plate Labeling protocol in the VWorks window 
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Setting up the protocol

Before you start

IMPORTANT VWorks Administrator or Technician privileges are required to 
make any changes to the protocol task settings.

Specifying the labware and the stackers

To specify the labware and the stackers:

1 In the protocol, verify that the correct labware type is selected:

a In the Main Protocol area, click the Plate Labeling icon.

b In the Task Parameters pane, locate Plate type, and verify that the 
selection is correct.

If the wrong labware is selected, click the Plate type list and select the 
labware that you are using.

2 Specify the BenchCel stackers that contain the labware to be labeled, as 
follows:

a In the Main Protocol area, click the Downstack task.

b In the Task Parameters pane, click Device Selection, and verify that the 
selection is correct.

CAUTION The label format selection and field information are saved with the protocol. If 
the label formats on the Microplate Labeler printer are changed, initializing the device will 
overwrite the information in the protocol. For example, suppose you selected a label format in 
the protocol called MyFormat. But, later, MyFormat is deleted from the printer. The next time 
you initialize the device and open the protocol, MyFormat will not appear in the protocol. 
Ensure that the label formats you are using are uploaded to the Microplate Labeler printer 
before you set the protocol task parameters. 

CAUTION Using labware other than one that has been defined in the Labware Editor 
can cause a collision, resulting in equipment damage. Ensure that the Plate type setting 
matches the labware that you use for the protocol.
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• Devices involved in area lists the stackers that hold the labware to 
be labeled. To remove a stacker from the list, double- click the 
stacker name.

• Devices available to perform task area lists the stackers that are not 
used in the Downstack task. To move a stacker from this list to 
the Devices involved in list, double- click the stacker name.

Figure Downstack task example for a BenchCel 6R

3 In the protocol, specify the empty BenchCel stackers where the BenchCel 
robot will store the labeled labware, as follows:

a In the Main Protocol area, click the Upstack task.

b In the Task Parameters pane, click Device Selection, and verify that the 
selection is correct.

• Devices involved in area lists the empty stackers that the BenchCel 
robot will use for upstacking the labeled labware. To remove a 
stacker from the list, double- click the stacker name.

• Devices available to perform task area lists the remaining stackers that 
are not involved in the task. To move a stacker from this list to 
the Devices involved in list, double- click the stacker name.

Figure Upstack task example for a BenchCel 6R

4 To save any changes, click File > Save on the VWorks menubar.

5 At the BenchCel Microplate Handler, fill the labware racks in the specified 
Downstack stackers with the labware to be labeled. Verify that the Upstack 
stackers are available for storing the labeled labware.
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For instructions on how to fill the labware racks, see the BenchCel 
Microplate Handler User Guide.

Specifying the Print and Apply task parameters

For each side of the labware, you select a label format and specify the 
information that will substitute for the text and barcode fields in the label 
format.

To specify the Print and Apply task parameters:

1 In the Main Protocol area, click the Print and Apply task.

2 In the Task Parameters pane, verify that the Format selection is correct for 
the South side of the labware. 

Note: The Device Selection area must specify the device for the task 
before you can enter the task parameters. For this protocol, the 
Microplate Labeler device has already been selected.

Figure Print and Apply task showing default task parameters

By default, this protocol uses Format 1. If you want to select a different 
format, click the Format box, and select from the list:

• Name or number. You can select from 9 templates (1–9), included with 
the Microplate Labeler, or any other label formats that you have 
created in Microplate Labeler Diagnostics. 

For details on how to create and edit label formats, see the Microplate 
Labeler User Guide.

If you do not see a list of formats, make sure the formats are uploaded 
to the printer, and ensure the Microplate Labeler device is initialized.

• Use from <side>. If you are using the same label on multiple sides, you 
can define the format for one side and then reference that side for the 
other sides.

• None. Indicates no label will be applied on the given side.

CAUTION Improperly seated labware can cause a hardware collision, resulting in 
equipment damage. Ensure that all labware are properly seated and in the correct 
orientation within the labware racks.
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3 Specify the information that you want to print in each field associated 
with the selected Format. 

a To edit a field, click the field, and then click the  button that 
appears. The Field Composer dialog box opens. See the following figure. 

b Use the Field Composer to specify the information to print for the 
given format field. 

Agilent recommends that you include the same information in both the 
human- readable text field and the field that contains the barcode symbol.

Note: The number of fields vary depending on the label format.

Figure Opening the Field Composer

For details on how to use the Field Composer, see the Print and Apply 
topic in the VWorks Automation Control User Guide.

4 To save any changes, click File > Save on the VWorks menubar.
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Format 1 description
The following table and figures describe the default settings in the protocol for 
Format 1, which has 2 fields: 

For Format 1 in this protocol, the Field Composer has only two types of Field 
Values defined by default: Static Text and Counter. 

Table Field Composer tools and values for Format 1(default)

Format 1 
fields

Description

1 Specifies the information that will be encoded in the barcode 
symbol.

Click the field, and then click the  button that appears. The 
Field Composer dialog box opens. Use the Field Composer to 
specify the information to print for the barcode symbol. 

2 Specifies the human- readable text that appears below the label. 

Click the field, and then click the  button that appears. In the 
Field Composer dialog box, specify the information to print for the 
barcode symbol. 

Format 1 
tools, 
default

Description and default value

Static 
Text

Prints the text that you want to appear on every label. 

Default value: Source 

To change the default text:

Click the  icon at the top of the Field Value area. In the 

Properties area, type the new text in the Static Text box.

Counter Prints a numeric or alphanumeric value that can be 
incremented.

Default value: 1:1:3:1:0

To change the default values:

Click the  icon at the top of the Field Value area. Set the 

following in the Properties area:

• Character Set. The option to use either numeric or 
alphanumeric characters.

• Start at. The starting value.

• Increment by. The amount by which the value increments.

• Total number of digits. The total number of digits or 
characters, including leading 0s.

• Increment every N plates. The increment value. For example, 
1 increments the value every microplate.
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You can delete the Static Text and Counter tools from the Field Value area in 
the Field Composer and use other tools from the Tools area instead. For a 
detailed description of the Field Composer tool options, see the Print and 
Apply topic in the VWorks Automation Control User Guide.

Figure Field Composer displaying default information for Static Text field

Figure Field Composer displaying default information for Counter field
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Running the protocol

Before you start 

About performing a mock run (optional)

IMPORTANT Always perform a mock run to verify that the Microplate Labeler 
plate stage positions are correct for the labware you are processing, and that 
the label locations on the labware are correct.

You prepare for a mock run the same way you would prepare for a real 
protocol run, except that you use empty labware for a totally dry run. 

Starting and monitoring the protocol run

To start and monitor the protocol run:

1 Compile the protocol and troubleshoot any errors as follows: 

a In the VWorks window, click Compile on the Control Toolbar. During the 
compiling process, the software reports errors found in the protocol 
and displays the errors in the Main Log area at the bottom of the 
VWorks window.

Note: The software automatically compiles the protocol when you 
start a run.

b Review the error and warning messages in the Main Log. You should 
fix all the errors. You can choose to ignore some of the warnings.

CAUTION A collision can occur if an object is placed in the path of the BenchCel gripper. 
To prevent potential equipment damage, ensure that the path is clear of objects, such as extra 
labware, that could cause a potential collision.



1   Automated Plate Labeling Protocol Guide
Running the protocol

20 Automated Plate Labeling Protocol Guide

2 In the VWorks window, click Start on the Control Toolbar.

The Run Configuration Wizard opens.

The Run Configuration Wizard allows you to:

• Specify the number of times to run the protocol.

• Schedule the run to start. You can start the run:

– As soon as possible
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– On a specific date and at a specific time

• Specify the starting barcode, if applicable. 

This feature requires a barcode scanner. 

• Type notes about the protocol.

3 Follow the instructions in the wizard and click Next or Finish, as applicable.

4 When the System Setup message appears, verify that the correct stackers are 
designated for the labware to be labeled, and then do one of the following:

Figure Example of System Setup message for BenchCel 4R

• If the setup is correct, click Continue to start the protocol.

• If the setup is not correct, make the required adjustments, and then 
click Continue in the System Setup message.

• If the wrong labware type is loaded in a BenchCel stacker, click Pause 
and Diagnose. 

In the Scheduler Paused dialog box that opens, click Diagnostics, and open 
BenchCel Diagnostics to release the labware. After resolving the 
problem, click Continue in the Scheduler Paused dialog box.

To monitor the progress of the run, check the Progress tab at the bottom of 
the VWorks window. 

CAUTION If you select the As soon as possible option, the protocol can start to run 
immediately after you complete the configuration wizard. Before you click Finish, verify 
that the system is set up and the protocol is ready to run.
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Figure Progress tab in the VWorks window

At the end of the run, the BenchCel stacker grippers automatically release the 
labware so that you can unload the labware. 

A protocol complete message appears.

Pausing and continuing the run

To pause and continue the run:

1 Click .

The task currently in progress finishes before the protocol pauses. The 
Scheduler Paused dialog box opens.
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2 When you are ready to resume the run, click Continue in the Scheduler 
Paused dialog box.

For details about the other options in the Scheduler Paused dialog box, see the 
VWorks Automation Control User Guide.

Stopping in an emergency

To stop in an emergency:

1 Press the red button on the emergency- stop pendant.

The Scheduler Paused dialog box opens.

To recover from an emergency stop:

1 If applicable, clear any obstacles from the Bravo Light Curtain. To 
reactivate the pendant, turn the red button clockwise. The spring- loaded 
button pops up.

CAUTION You might not be able to resume a protocol after an emergency stop. Do not use 
an emergency stop to pause a run. To pause and continue a run, use the Pause button. 
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2 Remove any dropped labware from the workstation. Remove the labware 
from the BenchCel gripper. 

3 In the Scheduler Paused dialog box, select the appropriate command. For 
details, see the VWorks Automation Control User Guide. 

Depending on the state of the workstation when the emergency stop was 
activated, the run may not be recoverable.

How to return to the Applications Library 

To return to the Applications Library display:

In the VWorks window, click the Applications Library.VWForm tab at the top of the 
protocol area. The Applications Library form appears in the VWorks window, 
as the following figure shows.

From the Applications Library form, you can open a different protocol or 
display the Literature Library.

Figure VWorks window displaying the Applications Library form
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